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MOLECULAR MODELLING EXERCISES 

 

OPIOIDS 

 

EXERCISE 24.12    OPIOID DIMERS 
 
Introduction 
 
Morphine is the active principle of opium and has powerful analgesic and sedative properties. 
The analgesic pharmacophore consists of the tertiary amine, phenol and aromatic ring. These 
groups interact with complementary binding regions in receptor binding sites (Chapter 24 in 
the textbook).   
There are three main types of opioid receptor responsible for analgesic activity – the mu, 
kappa and delta receptors. All of these have slightly different binding sites, but they all 
contain the same binding regions for the opioid pharmacophore. Therefore, achieving 
selectivity has been a bit of a challenge. However, it has also been found that opioid receptors 
can exist as homodimers in certain parts of the CNS (section 24.9.2 in the textbook). In other 
words, two identical receptor types are associated with each other. The separation between 
the component receptors in a homodimer also varies depending on the type of receptor 
involved. Therefore, opioid dimers have been synthesized in the belief that the presence of 
two pharmacophores separated by the correct distance would increase activity, as well as 
selectivity. Amongst these is an opioid dimer of naltrexone called norbinaltorphimine 
(nor-BNI) (section 24.10 in the textbook), which shows selectivity for the kappa receptor -
considered to be the safest analgesic receptor as it is free from the serious side effects 
associated with the mu receptor. A meso form of nor-BNI was also synthesized which consists 
of the active enantiomer of naltrexone linked to the inactive mirror-image enantiomer of 
naltrexone. The meso structure was expected to have poorer activity since it only contained 
one pharmacophore. However, it was found to have even greater activity than nor-BNI itself, 
implying that the presence of two complete opioid pharmacophores within the dimeric 
structure is not required for kappa activity and selectivity. This led to the proposal that the 
active enantiomer of naltrexone in the meso structure provides the pharmacophore required 
for analgesic activity, whereas a particular moiety in the inactive enantiomer is responsible 
for kappa selectivity. This corresponds to the message-address concept where one part of a 
structure acts as the message (the pharmacophore) and another part acts as the address 
(selectivity for a particular target) (section 24.9.1 in the textbook). Since nor-BNI and the 
meso form of nor-BNI both show kappa selectivity, it should be possible to overlay the 
analgesic pharmacophores of both structures and identify common feature(s) in the other 
half which may be responsible for kappa selectivity. 
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Figure 1 Nor-BNI and the meso form of nor-BNI. 
 
INSTRUCTIONS 
It is suggested that you attempt the following instructions yourself before following the more 
detailed Procedures that follow. You may find the file entitled Common Operations for 
ChemBio3D/Chem3D a useful guide on how to carry out various operations.  
 
PART A 
*Open ChemBio3D or Chem3D 
*Open the ChemDraw file of nor-BNI into ChemBio3D/Chem3D and energy minimise it. The 
ChemDraw file for the structure is available in the ChemDraw folder. Ensure that the 
piperidine rings are in the chair conformation and that chiral centres are correct. 
PART B 
*Open the ChemDraw file of the meso form of nor-BNI into ChemBio3D/Chem3D and energy 
minimise it. The ChemDraw file for the structure is available in the ChemDraw folder. Ensure 
that the piperidine rings are in the chair conformation and that chiral centres are correct. 
PART C 
*Compare the structures and identify any elements of symmetry in each. 
PART D 
*Overlay the two structures and assess which atoms might correspond to the address 
segment. 
PART E 
*Build the structures shown in figure 2 by modifying nor-BNI, then energy minimize them. 
*Overlay each of the analogues with nor-BNI and comment on whether this helps to explain 
their activity and selectivity.  
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  I       II 
Figure 2 Analogues of nor-BNI. 
 
PART F 
Structure III is a simplified analogue of nor-BNI that acts as a kappa antagonist and was the 
lead compound in the design and development of nalfurafine – a kappa-selective opioid 
(section 24.10 in the textbook). We will now compare structure III with nor-BNI.  
*Build the energy-minimised structure of the simplified analogue III (Fig. 3) by modifying 
nor-BNI. 
*Overlay the simplified analogue with nor-BNI. 
*Comment on whether it is likely to retain activity and selectivity for the kappa receptor. 
 

  
  III 

 

Figure 3  A simplified analogue of nor-BNI. 

 

PART G 

*Overlay the simplified analogue with the meso form of nor-BNI. 
*Comment on the results. 
 
  

HO
O

N

OH
H

S
O

OH

HO

N

similar properties
HO

O

N

OH
H

O

HO

OH
N

O

decreased selectivity



Patrick: An Introduction to Medicinal Chemistry 6e 
 

 

© Oxford University Press, 2017.  

PROCEDURES 
There are various approaches that you can use to tackle these molecular modelling exercises. 
The following procedures illustrate how you might tackle this particular exercise, but they are 
not meant to be prescriptive. Note also that the results obtained may vary depending on the 
computer and the version of ChemBio3D or Chem3D used. For example, the specific 
conformations obtained from energy minimisation may differ, as may quantitative results 
such as steric energies. 
 
PART A Nor-BNI and the meso isomer 
 
1. Use the ChemDraw file of nor-BNI to create an energy-minimised 3D model of nor-
BNI. 
 
*Open ChemBio3D or Chem3D. 
*From the File menu, choose Open, then select the ChemDraw file for nor-BNI from the 
ChemDraw folder. Click Open. 

*Energy minimize the structure .  
The steric energy for the energy-minimised structure (Fig. 4) is shown in the bottom window 
as 97.17 kcal/mol. 
 

 
Figure 4 Energy-minimised structure of nor-BNI with the piperidine rings in a twist-boat 
conformation. 
 
2. Ensure that the piperidine rings in nor-BNI are in the chair conformation. 
It is possible that the structure obtained after energy minimization has the piperidine rings in 
a twist boat conformation (Fig. 4). If so, modify the structure such that the rings are in the 
chair conformation. 

*Choose the Select tool . 
*Click on the nitrogen atom of one of the piperidine rings. 
*From the Structure menu, choose Invert. 
*Repeat this procedure to invert the nitrogen on the other piperidine ring. 

 *Energy minimize the structure . 
 
The modified structure now has both piperidine rings in the chair conformation (Fig. 5). The 
steric energy has also been reduced to 79.52 kcal/mol. 
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Figure 5 Energy-minimised structure of nor-BNI with piperidine rings in the chair 
conformation. 
 
3. Modify any incorrect chiral centres. 
It is important to check that the chiral centres have the correct absolute configuration. In this 
experiment, there is a faulty chiral centre highlighted in figure 6A. Correct any faulty chiral 
centres by inverting the centre as follows. 
 

 *Choose the Select tool . 
*Click on the chiral centre.  
*From the Structure menu, choose Invert. 

*Energy minimize the structure . 
The corrected structure is shown in figure 6B and has a steric energy of 75.89 kcal/mol. 
 

  
Figure 6 A) Identification of a faulty chiral centre. B) Inversion of the chiral centre 
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PART B  The meso structure of nor-BNI 
 
1. Create the energy-minimised structure of the meso form of nor-BNI. 
 
*Open the ChemDraw file of nor-BNI(meso) into ChemBio3D. The ChemDraw file is available 
in the ChemDraw folder. 

*Energy minimize the structure . 
The resulting structure has a steric energy of 85.18kcal/mol (Fig. 7). 
 

 
Figure 7  Energy-minimised structure of the meso form of nor-BNI (one of the piperidine 
rings is in the twist-boat conformation). 
 
2. Modify the structure such that piperidine rings are in the chair conformation. 
In the energy-minimised meso version of nor-BNI, one of the piperidine rings is in the twist 
boat conformation, while the other is in the chair conformation (Fig. 7). The same process 
described in part A is used to change the twist boat to the chair conformation. After energy 
minimization, the modified structure has a steric energy of 76.48 kcal/mol (Fig. 8). 
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Figure 8  Energy-minimised structure of meso nor-BNI, with both piperidine rings in the 
chair conformation. 
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PART C  Structural comparison of nor-BNI and its meso isomer. 
 
1. Orientate the molecules to observe any symmetry. 
Nor-BNI has a rotational symmetry around an axis through the central pyrrole ring. The 
phenol rings in each half of the molecule point in opposite directions (Fig. 9).  
 

  
 Figure 9  nor-BNI viewed from different perspectives to illustrate rotational symmetry. 
 
In contrast, the meso structure has a plane of symmetry through the pyrrole ring with both 
phenol groups pointing in the same direction (Fig. 10). 
 

  
Figure 10  The meso isomer of nor-BNI viewed from different perspectives to illustrate the 
plane of symmetry. 
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PART D  Overlay of nor-BNI with ite meso isomer. 
 
1. Recolour nor-BNI and hide hydrogen atoms and lone pairs 

*Choose the Select tool . 
*With the Shift key depressed, click on all the carbon atoms to highlight them. 
*Hover the mouse over any of the chosen atoms, then right click the mouse to produce a 
menu. 
*From the menu, select Color, then Choose color. Select your chosen colour from the colour 
palette, then click on OK 
*Repeat this process to recolour the nitrogen and oxygen atoms. 
 
2. Copy and paste nor-BNI and its meso isomer into a new window and align the 
structures. 
 
*Go to the window with nor-BNI. 

*Choose the Select tool . 
*Select the structure by lassoing it, or by double clicking on one of the atoms. Alternatively, 
choose Select All from the Edit menu. 
*Choose Copy from the Edit menu. 
*From the File menu, choose New to open a new window. 
*From the Edit menu, choose Paste to paste the structure of nor-BNI into the new window. 
*Repeat this process to copy and paste the meso isomer into the new window. 
*From the View menu, choose Model Display, then Show Lone Pairs. Select Hide.   
*From the View menu, choose Model Display, then Show Hydrogen Atoms. Select Hide.   

*Use the translate  and rotation  tools to orientate the molecules such that are aligned 
(Fig. 11). One structure can be moved selectively by selecting it, then moving it with the Shift 
key depressed. 
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Figure 11  Alignment of nor-BNI with its meso isomer. Atoms are paired up in preparation for  
the overlay. 
 
3. Pair up equivalent atoms in the structures to allow an overlay to be carried out. 

*With the Shift key depressed, use the select tool  to select an atom in one structure and a 
corresponding atom in the other structure.  
*From the Structure menu, choose Measurements, then choose Display Distance 
Measurement.  
*Repeat this process for other pairs of atoms as defined in figure 11.   
 
4. Overlay the structures. 
*From the Structure menu, choose Overlay, then click on Minimise. A dialogue box will 
appear.  
*Retain the default values of 0.100 for the Minimum RMS Error and 0.010 for the Minimum 
RMA Gradient. Check that the small boxes are ticked for Display Each Iteration, and Record 
Each Iteration. Click Start. 
 
In the trial experiment, the automatic overlay did not work particularly well with separations 
of 0.6-0.9 Å between the paired atoms. Therefore, one of the structures was selected and 
manually manipulated such that the paired atoms were closer. Another overlay minimization 
was then carried out which gave a better result where the paired atoms were separated by 
0.1 Å (Fig. 12). 
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Figure 12 Two different viewpoints of the overlay of nor-BNI (in green) with the meso 
isomer. 
 
The overlay shows that the opioid pharmacophores on the left hand side are well aligned, but 
that the opioid structures on the right hand side are pointing in opposite directions.  
 
5. Identify regions that might be acting as an address segment for the kappa receptor. 
Both nor-BNI and the meso isomer show selectivity for the kappa receptor, implying that 
there is a segment on the right-hand side that is shared between both molecules and acts as 
the address segment.  
* Measure the separation between the phenol rings, ether oxygens and alcohol groups in the 
right-hand side of the overlay. 
The separations between these groups are quite large (Fig. 13). All these features are in 
totally different regions of space and so none of these groups can be part of the address 
moiety. 

 
Figure 13 Distances between corresponding pairs of atoms on the right-hand side of the 
overlay (alcohol O-O = 4.7 Å; phenol O-O = 7.4 Å; ether O-O = 2.0 Å). 
 
*Identify equivalent features in the overlaid molecules that are in similar regions of space. 
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 The message pharmacophores are well superimposed, but there is very little evidence of 
equivalent features on the right-hand side of the overlay that could act as address features. 
For example, the amine groups are 3.9 Å apart in the overlay (Fig. 14). Given that there are no 
obvious common features, we have to consider the possibility that there is a structural group 
in each molecule that interacts with the same binding region, but that neither group is ideally 
placed for the strongest interaction. In other words, the two molecules may bind such that 
this binding region is between the two binding groups.  
The most likely group to consider is the amine group since this will be protonated at 
physiological pH and can form a strong ionic interaction. Therefore, it is possible that the 
amine is part of the message pharmacophore and that the amine is better positioned in the 
meso structure of nor-BNI than in nor-BNI itself. This implies that the optimum position of 
the amine group may be in the region between the two amines of nor-BNI and the meso 
isomer in the overlay.  
 

  
Figure 14  Separation of the nitrogen atoms in the overlay. 
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PART E  Analogues of nor-BNI 
 
1. Build the structure of analogue I by modifying nor-BNI. 
 
*Return to the window containing the energy-minimised structure of nor-BNI and copy the 
structure.  
*Paste nor-BNI into a new window. 
*Use the text tool  to change the pyrrole nitrogen atom to S. This creates the structure of 
analogue I (Fig. 14A). 

*Energy minimize the structure .   
 

 
   A      B 
Figure 14. Structures of analogues I and II. 
 
The energy-minimised structure for analogue I had a steric energy of 78.89 kcal/mol (Fig. 
15). 
 

  
Figure 15  Energy-minimised structure of analogue I from two different perspectives. 
 
2. Build the structure of analogue II by modifying nor-BNI. 
The same procedures are used to create analogue II.  
*Copy and paste the energy-minimised structure of nor-BNI into a new window. 
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*Use the text tool  to change the nitrogen atom of the pyrrole ring to an oxygen atom. 

 *Use the eraser tool  to delete the bond opposite the oxygen atom. 

*Use the bond tool  to create a 6-membered ring. 
 
The final energy-minimised structure had a steric energy of 70.5 kcal/mol (Fig. 16).  
 

  
Figure 16  Energy-minimised structure of analogue II from two different perspectives. 
 
3. Overlay analogue I with nor-BNI. 
*Copy and paste both structures into a new window. Select the recoloured version of nor-BNI 
from the previous overlay. 
*Align the structures one on top of the other, and move them into similar orientations. 
*Pair up atoms as shown in figure 17. 
 

 
Figure 17  Alignment of analogue I with nor-BNI, with atom pairings defined. 
 
*Overlay the structures. 
The overlay in the trial experiment required two successive overlay minimisations at a 
minimum RMS error of 0.100, followed by a third minimization carried out at a minimum 
RMS error of 0.010. This resulted in the paired atoms being separated by only 0.0-0.1 Å (Fig. 
18).  
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*Measure the separation between the nitrogen atoms in the address segment. 
 

   
  
Figure 18 Overlay of analogue I with nor-BNI. 
 
The thiophene ring in analogue 1 is not the same size as the pyrrole ring because the sulphur 
atom is larger and the bonds to sulphur are longer. This has the effect of shifting the position 
of the rings and atoms of the right-hand part of the molecule.  However, the differences are 
not massive and the important nitrogen atoms are quite close in the alignment. Therefore one 
would expect these structures to have similar activity. 
 
3. Overlay analogue II with nor-BNI. 
*Copy and paste both structures into a new window. Again, select the recoloured version of 
nor-BNI from one of the previous overlays 
*Align the structures and pair up atoms as shown in figure 19. 
 

 
Figure 19  Alignment of analogue II with nor-BNI. Atom pairings are defined. 
 
 *Overlay the structures. 
In the trial experiment, the initial overlay resulted in the paired atoms being separated by 0.1-
1.0 Å. There were no further improvements gained by repeating the operation. Therefore, the 
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structures were manually manipulated to bring the paired atoms closer. Another overlay 
minimization was then carried out to give a better overlay where the separation between the 
paired atoms was only 0-0.1 Å (Fig. 20). 
 

  
Figure 20 Overlay of analogue II with nor-BNI. 
 
Analogue II has a six-membered ring acting as the spacer, which causes a drastic shift in the 
position of the rings in the right-hand part of the structure. The important nitrogen atoms are 
now well-separated (4.3 Å) and so one would not expect this analogue to be very active or 
selective. This turns out to be the case. 
 

 
 
Figure 21 Diagram showing the N-N separation. 
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PART F  Overlay of analogue III and nor-BNI 
Analogue III (Fig. 21A) represents a simplified analogue of nor-BNI that retains the nitrogen 
atom thought to play a role in the address segment for the kappa receptor. We will build this 
structure and compare it with nor-BNI. 
 
1. Create the structure of analogue III from nor-BNI. 
*Copy the original energy-minimised structure of nor-BNI and paste it into a new window. 

*Use the Eraser  and Build tools to modify the structure in order to create analogue III. 

*Energy minimize the final structure . 
The energy minimised structure had a steric energy 49.18 kcal/mol (Fig. 21B). 
 

 
  A      B 
  
Figure 21  A) ChemDraw structure of analogue III. B) Chem3D-Model of analogue III. 
 
2. Overlay analogue III with nor-BNI. 
 
*Copy and paste the two structures into a new window. Choose the recoloured version of nor-
BIN from one of the previous overlays. 
*Align the structures and pair up equivalent atoms as shown in figure 22. 
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Figure 22  Alignment of analogue III with nor-BNI, with paired atoms defined. 
 
*Overlay the structures. 
Successive overlays led to a good overlay where the paired atoms were only separated by 0.0-
0.1 Å (Fig. 23). 
 
  
 

   
 
Figure 23  Overlay of analogue III with nor-BNI. 
 
3. Measure the distance between the nitrogen atoms in the address segments. 
*Choose the Select tool. 
*With the shift key depressed, click both nitrogen atoms to highlight them. 
*From the Structure menu, choose Measurements, then Display Distance Measurement. 
The distance between the two nitrogen atoms is 1.0 Å, which is within a bond length. 
 
4. Overlay molecules by pairing up only the nitrogen atoms. 

The previous overlay placed the emphasis for the overlay on matching up the message 

pharmacophores on the left-hand side of the structures. This resulted in the nitrogen atoms in the 

address segments being 1 Å apart. However, it is worth carrying out overlays using different 

pairings to see whether better overlays are possible. By pairing up the nitrogen atoms, the emphasis 

is on ensuring that the nitrogens in both the message and address segments are as close as possible. 

*Go to the window containing the overlay carried out above.  

*Click on the Undo icon  until the molecules are separated. 

*From the Structure menu, choose Measurements, then select Clear.  

*Pair up the nitrogen atoms as shown in figure 24 using the procedures previously described. 

*Overlay the structures. In the trial experiment, two successive overlay manipulations were carried 

out, then a manual manipulation was carried out. A third overlay was carried out at a minimum 

RMS Error of 0.01 to give an overlay where the message nitrogen atoms and the address nitrogen 

atoms were only 0.1 Å apart (Fig. 25). The phenol rings are not perfectly aligned. On the other 

hand, they are reasonably close, and so they could both conceivably form the same interactions 

with the binding site. The choice of which overlay is used often depends on which priorities the 

operator considers most important. 
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Figure 24  Pairing up the nitrogens prior to an overlay. 
 

  
Figure 25  Overlay of the structures by pairing nitrogen atoms (two different perspectives). 
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PART F  Overlay of analogue III and the meso isomer of nor-BNI 
*Copy and paste both molecules into a new window and recolour the meso form of nor-BNI. 

*Pair up atoms relating to the opioid message pharmacophore (Fig. 26). 

 
Figure 26  Pairing up atoms between analogue III and the meso form of nor-BNI (shown in 
pink) 
 
The resulting overlay (Fig. 27) was good for the paired atoms, but the nitrogen atoms in the 
address moiety are 2.6 Å apart (Fig. 28), which means that the simplified structure is closer in 
nature to nor-BNI. On the other hand, if we compare figure 28 with figure 14, the nitrogen of 
the analogue is 1 Å closer to where the N of the meso structure is located. This may well be 
advantageous if the optimum position for the nitrogen atom is between the positions 
occupied by the two isomers of nor-BNI.  
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Figure 27  Overlay of analogue III with the meso form of nor-BNI  
 

   
Figure 28  Overlay of analogue III with the meso form of nor-BNI, including measurement of 
N-N separation in the address segment.  
 
 
 


